# Contents

**WELCOME TO IMO** .......................................................................................................................... 1

Introduction ........................................................................................................................................... 1
Main features ......................................................................................................................................... 1
What's new in IMO 1.5 ......................................................................................................................... 2
Hardware and system requirements ..................................................................................................... 2
Installing, Starting and Uninstalling IMO ............................................................................................. 2
Getting assistance ............................................................................................................................... 3
Technical support ............................................................................................................................... 3
Screen Layout ...................................................................................................................................... 4

**WORKING WITH IMO** ...................................................................................................................... 6

**BASIC OPERATIONS** ....................................................................................................................... 13
Open an existing model ......................................................................................................................... 13
Adding to an opened model .................................................................................................................. 13
Selecting shapes .................................................................................................................................. 13
Deleting shapes .................................................................................................................................... 13
Merging shapes ..................................................................................................................................... 14
Undo/Redo operations .......................................................................................................................... 14
Get model information ......................................................................................................................... 14
Save a model ....................................................................................................................................... 15
Publish a model .................................................................................................................................... 15
Upload the scene to the World Wide Web ............................................................................................. 16
Creating Internet Scene Assembler objects using IMO ......................................................................... 16

**SCENE TREE WINDOW** ................................................................................................................ 17
Overview .............................................................................................................................................. 17
Renaming nodes .................................................................................................................................... 17
Selecting in the Scene Tree ................................................................................................................... 18
Scene Tree commands .......................................................................................................................... 18
Using shortcut keys for Scene Tree ...................................................................................................... 19

**3D VIEW WINDOW** ........................................................................................................................ 20
Overview .............................................................................................................................................. 20
Moving around: PLAN, PAN, TURN and ROLL ...................................................................................... 20
Fit and Align ......................................................................................................................................... 21
Controlling model view ........................................................................................................................ 21
Keyboard commands ............................................................................................................................ 22
Selecting in the 3D View ....................................................................................................................... 22
Setting 3D View window options ........................................................................................................ 22

**OPTIMIZATION AND CONVERSION** ............................................................................................ 24
Preprocessing ....................................................................................................................................... 24
Preprocessor Options ........................................................................................................................... 24
Optimizing polygonal mesh of objects ................................................................................................. 25
Step-by-step optimization .................................................................................................................... 25
Spline Surface ...................................................................................................................................... 26
How to convert VRML nodes ................................................................................................................ 26
Crease Angle Tuner ............................................................................................................................. 27
Batch optimization .................................................................27
Edit Edges ..............................................................................28
Edit Vertices ........................................................................28

MATERIAL EDITOR ................................................................30
Procedures ..............................................................................31
Designing Materials .............................................................31

GLOSSARY ...............................................................................33
Welcome to IMO

Introduction

Welcome to Internet Model Optimizer (IMO) from ParallelGraphics. IMO is a next generation tool which provides an efficient way to optimize complex 3D models originating from CAD/CAM/CAE systems, medical data acquisition, range scanners, and other sources for use on the Internet. In many cases, the number of primitives in these models overwhelms the rendering performance of current graphics systems.

One method for accelerating the rendering of these environments is polygonal simplification. The aim of polygonal simplification is to remove primitives from an original mesh in order to produce simpler models that retain the important visual characteristics of the original object. We use a successive vertex removal technique with the corresponding triangulation to gradually simplify a model. This method is relatively fast and allows us to simplify large polygonal models with hundreds of thousand of polygons in several minutes using ordinary PCs (PII, PIII, 128MB).

Internet Model Optimizer offers you a wide range of optimization modes – from batch processing to manual mode with the ability to also only optimize selected parts of the model.

Main features

IMO offers you visual support for every step of processing, in that all manipulations with optimization parameters are dynamically displayed in the 3D window. In addition, IMO supports various representation modes of 3D models: Solid, Wireframe, Vertices and Show Only Selection.

Optimization
- Preprocessing: to join together several abutted shapes.
- The ability to optimize a selected set of shapes.
- Excluding VRML primitives from the optimization process.
- Support for textures.
- Batch optimization.

Edit modes
- Edit Shapes: simplification of a model.
- Edit Edges: the ability to flip edges and show acute edges.
- Vertex editing: adding, deleting, and moving.

Improving surface quality
- Converting the model into its spline representation and vice versa.
- Crease angle tuning to create a smooth look.

Publishing on the Web
- IMO allows you to publish the finished scenes on the Web and view them in all major VRML browsers.

Supported formats
- File formats for reading: VRML 1.0, VRML97, DXF v.12 (AutoCAD).
- Output format: VRML97.
- Support for GZIP compression.

IMO operates with the components of a scene graph – VRML97 nodes, called shapes:
- IndexedFaceSet.
- VRML primitives: Box, Cone, Cylinder, ElevationGrid, Extrusion, Sphere, Text.
- SplineFaceSet – spline equivalent of the IndexedFaceSet VRML node (VRML extension in Cortona).
Welcome to IMO

What's new in IMO 1.5

- IMO imports the VRML scene, keeping the transformation hierarchy of the model's parts and displaying it in the Scene tree. It is useful in cases where you want to develop animations to be used for product demonstrations and instruction manuals.
- Support for instantiation. Using multiple references to the same geometry usually leads to more effective results in optimizing models with complicated structures.
- The Add command. This places the geometry from other files in a currently opened scene.
- The ability to edit and preview materials. IMO comes with a library of materials to help you create greater realism with models.
- The shape details option in the Scene Tree gives you easy access to the statistical information about a selected shape in the management of its size and complexity.
- A shape merge to create a compound object.
- The ability for converting primitives to the IndexedFaceSet VRML nodes during the preprocessing procedure.
- Multiple selection by drawing a rectangle in the 3D View window.
- Support for inlining. This enables you to open a model with its parts in separate VRML files.
- A navigation paradigm in the 3D View window has been changed for the Turn and Plan navigation modes (CAD-like navigation).

Hardware and system requirements

- Operating system: Microsoft® Windows® 95/98/ME/2000 or Windows NT® 4.0, Internet Explorer 4.0 or a later version.
- Processor: Pentium® 166 MHz minimum (Pentium® III 800 MHz recommended).
- Random Access Memory (RAM): minimum of 64 MB (512 MB recommended).
- Graphic card: 800x600x16-bit color supporting, 8MB memory minimum (32MB, OpenGL and Direct3D hardware acceleration recommended).

Installing, Starting and Uninstalling IMO

IMO is delivered as a downloadable package. The Setup program provided with each package creates all necessary folders on your hard disk and installs all necessary software components.

To install IMO:

1. Start Windows.
2. Run the setup program received from ParallelGraphics. An IMO Setup splash screen appears.
3. Follow Setup instructions.
4. To start the program, click the Start button, point to Programs, point to ParallelGraphics, choose Internet Model Optimizer and then click Internet Model Optimizer.

To uninstall the IMO program:

1. Click the Start button, and then point to Settings.
2. Click the Control Panel and then double-click the Add/Remove Programs icon.
3. In the dialog box select Internet Model Optimizer and click the Add/Remove button.
4. Click Yes if you want to remove the IMO installation completely. Click No if you have decided to keep IMO.
Note:
- The Unwise program deletes all the standard IMO components and registry entries. You must manually remove any shortcuts to IMO that you have created elsewhere.

Getting assistance

You can get help without interrupting your work.

For a brief description of a menu command:
- Position the pointer over the command – the description appears on the Status bar
- Or position the pointer over the menu item and press F1.

For a description of a toolbar button:
- Position the pointer over the button – the name appears below the button
- Or press SHIFT+F1, then click the button.

Technical support

We are interested in receiving your feedback about IMO. For product support, you can send an email to support@parallelgraphics.com. Before posting your message, please follow these simple instructions:

1. Check the online Help service.
2. Include in your message any information that could help better answer your question or make solving the problem easier.
3. Document the system configuration: OS version, CPU type, memory, graphics card, monitor, etc.
4. When error messages occur, please document the complete message including sub-dialog details and provide step-by-step instructions that will allow us to recreate the problem.
Screen Layout

When you start IMO you see an arrangement of screen elements, which is described below.

**3D View window**
3D scenes or models are viewed here. You can navigate the camera using the mouse or keyboard. Some IMO commands and options of 3D View can be accessed by pressing the right mouse button while the pointer is over this window.

**Scene Tree**
This window is used for viewing, selecting, merging or removing constituent shapes of the current scene. Some IMO commands can be accessed by pressing the right mouse button while the pointer is over the item.

**Main menu bar**
Located at the top of the screen. Some menu commands duplicate the function buttons in the Standard, Edit, Action and View toolbars.

**Standard toolbar**
Buttons for managing files, Undo and Redo actions, removing and selecting shapes.

**Action toolbar**
Buttons for preprocessing, optimization, conversions to or from spline surfaces, Crease Angle Tuner and Material Editor.

**Edit toolbar**
Contains buttons that allow you to change the editing mode of IMO.
Status bar
Located at the bottom of the IMO screen.
You can read short explanations for the commands and program status information here.

View toolbar
Controls for headlight, wireframe mode, appearance of the selected shapes in the 3D View window, and navigation.

By default, there are two main windows in the IMO:

• Scene Tree (to the left) – displays the transformation hierarchy of the scene. This window is used for viewing, selecting, merging or removing constituent shapes within the structure of the current scene or model.

• 3D View (to the right) – the 3D scene is viewed here. You may navigate with the camera using the mouse or keyboard. Cortona VRML client is used as a viewer in this window.
Working with IMO

This is step-by-step tutorial in which you optimize a model and learn to perform basic operations in IMO. To begin the tour, download the model from the http://www.parallelgraphics.com/products/imo/examples Web site.

Initial model

Scene size: 2.65 MB (uncompressed)
Number of triangles: 74522
Number of shapes: 33

Preprocessing

Perform preprocessing by choosing Preprocess Model from the Action menu. During preprocessing, abutted shapes with the same material are joined to the single shape and closely spaced vertices are combined.

Note: It is strongly recommended to preprocess the model before optimization.

Number of shapes:
Before preprocessing: 33
After preprocessing: 27

Number of vertices:
Before preprocessing: 40244
After preprocessing: 39859
Optimization

Select the shapes to be optimized and start the optimization process.

Set the maximal reasonable Optimization ratio.
Optimization in progress

In accordance with chosen settings, IMO generates an optimization database of polygons to be removed.

Tune Optimization Ratio

Now you can choose the desired polygon count by dragging the slider. All changes are immediately displayed in the 3D window.

Moreover, you can:
- navigate in the 3D window,
- test the simplified shapes in various viewing modes - Solid, Wireframe, or Vertices,
- use the Highlight Selection and Show Only Selection options.
Excluding shapes from optimization process

As the destination optimization ratio for various shapes can be different, you can gradually exclude shapes from the optimization process. Drag the slider in the Choose Optimization Ratio dialog to the right until all the selected shapes look correct in the 3D window, then deselect the shapes you do not want for further optimization, and so on.

Close the Choose Optimization Ratio dialog to complete optimization.
Converting to splines

You can convert a polygonal model to its spline representation in order to improve the surface quality. **Note**: Spline representation is only supported by ParallelGraphics' Cortona VRML client. Other VRML browsers will show it as a polygonal model.

Crease Angle Tuning

Tune the crease angle for selected shapes to achieve a smooth look.
Drag the slider, or enter the crease angle value in degrees, then click Apply to preview the result in the 3D View window.

Finally, you can clean up the optimized model by manual editing. IMO supports three editing modes: shapes, edges, and vertices editing.
Edit Vertices

The Edit Vertices mode allows you to add, delete and move the vertices.

Publish a model

Publish the finished model. IMO creates a new folder in which all data describing the model is placed. This sub-folder will contain the model's .wrl file and the other resource files – textures. After the folder is created you may upload the model to your Web site.

Finished model

Scene size: 63 KB
Number of triangles: 7862
Basic Operations

Open an existing model

To open a model from a specified file:

1. Click the Open button on the Standard toolbar or choose Open from the File menu.
2. In the Files of type box, select the VRML Files or the DXF Files item.
3. In the Look in box, click on the location of the file.
4. Below the Look in box, double-click the folder you want. Continue double-clicking sub-folders until you open the sub-folder that contains the model.
5. In the file list, click the file name.
6. Click Open.

A new model or scene is then opened and shown in the 3D View window. The shapes of the current model are displayed in the Scene Tree window.

Note:
- You can also open an existing model by dragging its file onto IMO's title bar.
- To open a model you've used recently, click its name at the bottom of the File menu.

Adding to an opened model

To place geometry from other files to a currently opened scene:
- Click Add from the File menu, select the VRML or DXF file in the standard file selection dialog, and click Open. This merges the scene from other files to the current scene.

Selecting shapes

To manipulate a shape you should select it in the 3D View or Scene Tree window. For details on selecting, see Selecting in Scene Tree and Selecting in 3D View.

Selection related commands:
- The Select All command (Edit menu) selects all of the shapes.
- The Show Only Selection command (View menu) allows you to display in the 3D View window only those shapes that were marked in the Scene Tree window.
- The Highlight Selection command (View menu) allows you to highlight the selected shapes in the 3D View window. Please note that you can change the default color for the selected shape: right-click somewhere in 3D View, choose Properties, click the Colors tab, select ShapeHighlightColor in the Properties list, choose a color set from the list, select the desired color from the Color Palette, and click OK.
- The Invert Selection command (Edit menu) marks all shapes in the Scene Tree window which were not marked and unmarks the previously marked shapes.

Deleting shapes

To delete selected shapes in the model:

1. Select the shapes to be deleted.
2. Choose Delete Selection from the Edit menu or click on the Standard toolbar or press the Delete key. Please note that when you delete the shape, all the instances (if any) of the shape will be deleted. The parent transformation nodes that should appear without descendants will also be deleted.
To delete an instance of a node:

1. Find the shape in the 3D View window and click it. The corresponding node name in the Scene Tree appears in a gray color.
2. Right-click this node in the Scene Tree and select Delete Node from the pop-up menu.

Merging shapes

This procedure allows you to merge all shapes in the scene to a single shape. In some cases, removing the hierarchy information allows you to decrease the size of the resultant VRML file.

To merge all shapes in scene:
• Choose Merge All from the Action menu.

Notes:
• In general, shapes in a scene have different materials, textures, crease angle and solid attributes. When merging, the resultant shape will have the visual attributes of the first shape found in the scene hierarchy.
• If a scene contains instantiation, the size of the resultant VRML file can be increased because all multiple references should revert to the unique geometry.
• IMO allows you to merge the descendant shapes of the transformation node. For more details, see Scene Tree commands.

Undo/Redo operations

To reverse the last operation, use the Undo button from the Standard toolbar or select Undo from the Edit menu. Immediately after you undo an action, the Redo command changes to Redo, allowing you to restore what you have reversed.

To reverse the action of the Undo command, use the Redo button from the Standard toolbar, or select Redo from the Edit menu.

Get model information

To get information about a model:

• On the File menu, click Model Info, the Model Info dialog box appears. IMO displays statistical information about the current scene for managing overall scene size and complexity. This also enables scaling operations with the model. All parameters in the Size box are in metres.

Original presents information about the number of faces, triangles and vertices in the currently opened scene before any processing occurs. It is useful to compare the degree of simplification and set your preferences accordingly. Please note that all instances in the scene make a contribution to the displayed numbers since they represent the geometry to be rendered.

Current: presents information about the geometry used for rendering for the current step of the optimization process.

Unique: only displays the unique geometry (without references) for the current step of the optimization process.

Primitives: this gives information about the geometry used by primitives for the current step of the optimization process.
**Basic Operations**

**To scale a model uniformly along all three axes:**
- Type the desired new X, Y, or Z size (in metres) of a model in the corresponding box, then click OK.

**Note:** IMO assumes units to be in metres. If the units in the imported file do not match this system unit, you can convert the units by scaling a model.

**Save a model**

**To save a model with the same name:**
- Click Save on the Standard toolbar, or
- On the File menu, click Save.

**To save a copy of a model:**
1. On the File menu, click Save as. The Save Scene dialog box appears.
2. In the Save in box, click the location of the model.
3. Below the Save in box, double-click the folder you want.
4. In the File Name box, type a new file name for the model.
5. Click Save.

**To save selected shapes in a separate VRML file:**
1. Select the shapes to be saved.
2. On the File menu, click Save Selection.

**Publish a model**

When you choose to publish the file, all of the extra formatting is removed, and the file is reduced to its minimum size. In addition to this, compression can also be added at this stage. To prepare a model for publication, IMO creates a new folder in which all data describing the model is placed. This subfolder will contain the model’s .wrl file and the other resource files – textures. After the scene is published you may upload the model to your Web site or use it in ParallelGraphics Internet Scene Assembler.

**To prepare the model for publication:**
1. Move the camera to the location you need by using the navigation commands in 3D View.
2. On the File menu, click Publish. The Publish Scene dialog box appears.
3. To save the model in a location other than a folder which is suggested by the default, click a different drive name or folder name.
4. To save the model in a new folder, click .
5. In the Name box, type a name for the model.
6. Mark the desired check box near the corresponding item:
   - **Compress VRML file** – saves outgoing file in a compressed format.
   - **Put all resources in one folder** – to have all files of your model in one folder. Clear the check box to place resources independently.
   - **Shapes with transforms** – when checked, this puts every shape inside a Transform node. This allows the developer to animate any part of the model in ParallelGraphics Internet Scene Assembler at a later stage. See also Creating Internet Scene Assembler objects using IMO.
   - **Combine unnecessary transform** – when checked, this option replaces all the children transformation sequences without shapes (when the Transform node contains the only other Transform), with the equivalent parent Transform.
   - **Save current viewpoint** – when checked, this stores the current camera position as a viewpoint.
7. Click OK.
Upload the scene to the World Wide Web

To upload a scene to Web:

- Choose **Post To Web** from the **File** menu or click the button on the Standard toolbar, and then follow the instructions displayed on the screen.

**Notes:**
- Consult with your Internet Service Provider or Network administrator with regard to how to set the correct data in the dialogs displayed on your screen.
- Install the Web Publishing Wizard software, distributed freely by Microsoft Corp. in order to use this feature of **IMO**.
- When uploading, **IMO** automatically publishes a scene with the options specified in the Publish Scene dialog box (click Publish from the File menu to display).

Creating Internet Scene Assembler objects using IMO

This section provides suggestions for ways you can use **IMO** to create objects for Internet Scene Assembler (ISA), the VRML authoring tool from ParallelGraphics for building interactive scenes.

**IMO** generates the VRML97 file and therefore the optimized model can be imported to ISA. Moreover, if the model has sub-objects, all of these objects can be animated in ISA.

**To prepare the model for animating in ISA:**

1. Choose **Publish** on the **File** menu. The Publish Scene dialog box appears.
2. Make sure that the **Shapes with transforms** check box is selected. Click OK. See Publish a model for details.
3. Import your model to ISA Pro by using **Import** on the **File** menu.
Scene Tree Window

Overview

A VRML file is hierarchical; node statements can contain field statements that in turn contain node (or a reference to a node) statements. This hierarchy of nodes is called the scene graph. In VRML it is possible to create any number of coordinate systems for positioning shapes. Each new coordinate system is positioned, or translated, relative to the origin of another coordinate system. The transformation hierarchy includes all of the root (primary) nodes and root node descendants that are considered to have one or more particular locations in the virtual world.

The Scene Tree window presents information about a model structure and shows the transformation hierarchy of geometry nodes. There are two different kinds of VRML nodes displayed in this window: transformation and geometry nodes. In IMO, the geometry node is called a shape.

The Scene Tree is very similar to a genealogical tree. Each transformation node may hold any number of children nodes (sub-objects) and defines a new coordinate system for its children. A node that contains one or more children is called a parent node. Each node, with the exception of the root nodes, has a parent.

A + symbol indicates that a level has collapsed. Click the + symbol to expand the level of the transformation hierarchy. The figure below shows the transformation hierarchy view of the model in the Scene Tree window with all the levels expanded:

Each node type has a particular icon that is associated with it in the Scene Tree:

- □ – marks the transformation node.
- □ – a red icon represents a negative transformation. This is a transformation with the negative values in the scale fields. Such a transformation generally produces a mirror image of the original surface.
- □ – represents an ordinary polygonal shape (an IndexedFaceSet VRML node). These shapes may be simplified and converted to SplineFaceSet.
- □ – SplineFaceSet (VRML extensions in Cortona).
- □ – Primitives: Box, Cone, Cylinder, ElevationGrid, Extrusion, Sphere and Text. These shapes cannot be simplified.
- □ – If a node refers to a previously defined node, the link mark appears above the node icon.

On the left of the node icon, there is a check box that can be marked to select shapes, see Selecting shapes in the Scene Tree. A text field on the right of the icon displays a node name. You can rename the node, see Renaming nodes.

When you click the right mouse button anywhere in an item, IMO displays a menu of common commands at the mouse pointer (see Scene Tree Commands).

Renaming nodes

Using the Scene Tree, you can rename a node with the appropriate renaming of all its instances (clones).
To change the name of the tree node:

1. Click the node name, then press F2. You can also click it twice.
2. Type the new name in the text box, and then press ENTER or press ESC if you want to leave the text box unchanged.

Note:
• The VRML node name in the Scene Tree window cannot start with a number or " +" or "-" characters. The following characters cannot be used for node names: space, comma, periods, single and double quotation marks, "#", "\", "{", "}", "[", "]". IMO replaces these characters with the question mark "?"
• If the node name you have entered is already in use, IMO automatically adds a number at the end.

Selecting in the Scene Tree

This procedure allows you to select shapes of the model to be examined and optimized. It is useful in cases when you want to optimize a model with a complicated model structure.

Selecting in the Scene Tree window:
• To select a shape in the Scene Tree, mark the check box on the left of the corresponding icon.
• To select multiple shapes, mark the check boxes one by one.
• To select a group of nodes that are next to each other and members of the same hierarchy level, mark the check box of the first node, and then click the check box of the last node while pressing the SHIFT key.
• To cancel the selection, clear the corresponding check boxes or click anywhere on an empty part of the 3D View window.
• To cancel the selection of a group of adjacent nodes that are members of the same hierarchy level, clear the check box of the last node to be cleared, then click the check box of the first node while pressing the SHIFT key.

Note:
• When you select a shape, all instances of the shape are also selected.
• Marking the check box of the transformation node in the Scene Tree window results in the selection of the whole hierarchical branch beginning with the first level.
• If not all of the descendants of the transformation node are marked, the corresponding check box is grayed.
• The selected shapes can be highlighted in the 3D View window if the Highlight Selection button is pressed.

Scene Tree commands

The following context-sensitive commands can be accessed by pressing the right mouse button while the pointer is over the node in the Scene Tree window.

Fit In
Makes a current shape fully visible in the 3D View window. If you apply this command to a transforming node, this makes all the children shapes visible in 3D View. You can also double-click the corresponding icon in the Scene Tree to fit in.

Delete Node
Removes a node located in the place where you have pressed the right mouse button.
If you delete the node reference, or a node definition, which has a number of references, only the indicated instance is removed. If you delete the shape, all the parent transformation nodes that do not
hold other children nodes are also removed. Deleting the transformation node results in the removing of all its children nodes and the parent transformations without shapes.

**Details (only for a shape node)**
Displays statistical information about the current shape for managing its size and complexity. The Solid check box allows you to control whether one or both sides of each polygon, forming a shape, will be displayed. If it is cleared, each polygon is visible regardless of the viewing direction.

**Merge Children Shapes (only for transformation nodes)**
This procedure allows you to merge all the descendant shapes of the transformation node to the single shape. For details, see Merge scene.

**Go To Definition**
To jump to the definition of the selected instance of a node.

**Go To Next Reference**
To jump to the next instance of the selected node:

**Expand All**
Expands all levels if they are collapsed.

**Collapse All**
Collapses all levels if they are expanded.

**Expand Selection**
Expands the current selection if it is collapsed. The branches without selected shapes are collapsed.

### Using shortcut keys for Scene Tree
You can manipulate in the Scene Tree window by using keyboard shortcuts. To use keyboard commands, make sure the Scene Tree window is active. To activate the Scene Tree window, click anywhere on an empty part. The current level in focus appears in a blue color.

<table>
<thead>
<tr>
<th>To</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand the current level of the transformation hierarchy if it is collapsed</td>
<td>RIGHT ARROW</td>
</tr>
<tr>
<td>-Or- Move the focus to the first sub-level.</td>
<td></td>
</tr>
<tr>
<td>Collapse the current level of the transformation hierarchy if it is expanded</td>
<td>LEFT ARROW</td>
</tr>
<tr>
<td>-Or- Move the focus to the parent level.</td>
<td></td>
</tr>
<tr>
<td>Expand the current level.</td>
<td>PLUS SIGN (+)</td>
</tr>
<tr>
<td>Collapse the current level</td>
<td>MINUS SIGN (-)</td>
</tr>
<tr>
<td>Expand the current level and all its children levels of the transformation hierarchy.</td>
<td>SIGN(*)</td>
</tr>
<tr>
<td>Select or cancel the selection of the current node.</td>
<td>SPACEBAR</td>
</tr>
</tbody>
</table>
3D View window

Overview

3D scenes or models are viewed here. This window provides navigation paradigms (such as examine or flying) that enable the user to move the viewer through the virtual world. You can navigate with the mouse, the keyboard, or both the mouse and keyboard. Some IMO commands and 3D View options can be accessed by pressing the right mouse button while the pointer is over this window.

Related topics about 3D navigation:
Moving around: PLAN, PAN, TURN and ROLL
Fit and Align
Keyboard commands
Selecting in the 3D View
Setting 3D View window options

Moving around: PLAN, PAN, TURN and ROLL

Moving through a 3D space is similar to moving a camera. Think of a video camera that captures images in the real world and converts them into electronic signals for viewing on a screen. Your movements in the world continually position and orient that camera. The following figure shows a world coordinate system represented as a set of X, Y, and Z axes (the Y axis is in the up direction), and the camera coordinate system is also shown with its own X, Y, and Z axes:

There are four main navigation modes in the 3D View window: PLAN, PAN, TURN and ROLL. They provide a hint to the IMO program about which interactive viewing method is most appropriate when you explore a model.

You can navigate with the mouse, the keyboard, or both mouse and keyboard. To move around a 3D world using the mouse:

1. Choose a navigation mode by clicking the appropriate button on the View toolbar or selecting Navigation Mode on the View menu.
2. Position the pointer anywhere in the 3D View window and press the left mouse button.
3. Move the mouse while holding down its left button. The direction in which you drag the mouse determines the viewer motion.
4. Release the left mouse button to stop moving.

Note:
The distance that you drag the mouse determines the speed with which the camera moves. If you stop moving the mouse, the viewer will continue moving until you release the mouse button.

To select the navigation mode quickly, hold SHIFT, CTRL, or SHIFT+CTRL when you move the mouse with the left button pressed. The SHIFT and CTRL keys allow the user to quickly change the navigation option to PAN and TURN accordingly. When the SHIFT and CTRL keys are pressed simultaneously the ROLL navigation mode is activated.
3D View window

Use PLAN to move a camera closer or further.

Move the mouse a short distance forward or backward:
Forward – move the camera closer (in the positive Z direction of the camera)
Backward – move the camera further away (in the negative Z direction of the camera)

Use PAN to move a camera within a vertical plane that coincides with the plane of your screen.

Move the mouse a short distance in any direction:
Forward – move the camera up (in the positive Y direction of the camera)
Backward – move the camera down (in the negative Y direction of the camera)
Right – move the camera to the right (in the negative X direction of the camera)
Left – move the camera to the left (in the positive X direction of the camera)

Use TURN to examine an object from various angles.

Position the pointer over the object you’d like to examine. Press the left mouse button. Drag the mouse to move the camera around the point on the object where you press the button. The model appears as if you are turning it around the selected point. The direction in which you drag the mouse determines the one for the model’s rotation.

If there is no face at the point where you have pressed the mouse button, the camera moves around the center of bounding box of selected shapes or the coordinate origin of the scene if there is no selection.

Use ROLL to incline the camera to the left or right.

A 3D scene appears as if you are inclining your head to the left or right.

Move the mouse a short distance in any direction:
Right – incline to the left (a negative rotation of the camera around its Z axis)
Left – incline to the right (a positive rotation of the camera around its Z axis)

Fit and Align

There are two mechanisms that can help to re-orient a camera if you have lost your way in a world.
Unlike the navigation tools, these buttons invoke predefined actions that take place as you click on them.

Use ALIGN to position the camera’s horizontal and longitudinal axes parallel to a world horizontal plane.

Use the FIT From commands to make the selection fully visible in the 3D View window from different points of view. If there are no selected shapes in the model, this command allows you to explore the entire model. The command can also be accessed from the context-dependent pop-up menu in the Scene Tree window.

Controlling model view

These commands enable you to display the model in several ways: normal view, the line segments of the solid objects, and their vertices.
To set the rendering method:

- Choose View menu, model view, and click the desired method.
  - Solid view
  - Wireframe view
  - Vertices view.

Keyboard commands

You can control the camera using keyboard commands:

- Arrow Up - move closer.
- Arrow Down - move further.
- Arrow Right - turn to the right.
- Arrow Left - turn to the left.

Note:
- To accelerate the camera's movement: Press SHIFT, CTRL or SHIFT+CTRL and one of the above keys simultaneously.
- The navigation keyboard commands are available only when the 3D View window is in focus. Just click somewhere in the 3D View before using the keyboard.

Selecting in the 3D View

Use the following procedures to select a shape or shapes for manipulation:

- To select a shape, click a shape in the 3D View window: This highlights the shape if the Highlight Selection button is pressed. The corresponding node name in the Scene Tree appears in a gray color.
- To select multiple shapes in the 3D View window, hold down the CTRL key, and then click each shape in the 3D View you want. Clicking on the previously marked shape while holding down CTRL unmarks it.
- To select shapes that have their faces behind the rectangle drawn in the 3D View, press the left mouse button with ALT pressed in the place where you want the rectangle to start, and then continue to move the mouse and release it wherever you want to select shapes. Pressing SHIFT+ALT results in deselecting shapes behind the rectangle.
- To cancel all selections, click anywhere on an empty part of the window.

Note:
- If the Show Only Selection option (View menu) is turned on, it is impossible to cancel the selection by clicking on an empty part of the 3D View window.
- When you select a shape, all the parent transformation nodes and instances of the shape are also selected.

Setting 3D View window options

The following options are available from the right-button pop-up menu of the 3D View window:

- Speed. Controls the rate at which a camera moves through a world.
- Headlight. The headlight always shines directly in front of the camera. You can switch the headlight on and off.
- Show Only Selection. Allows you to display in the 3D View window only those shapes which were marked in the Scene Tree window.
• **Highlight Selection.** This highlights the selected shapes in the 3D View window.
• **Hide invisible edges.** In Wireframe view, this hides edges which are formed by the invisible (with normals from the viewer) triangles.
• **Properties.** Allows you to change the renderer options and change the appearance of the screen elements:

  **Renderer**
  Select a rendering mode. To draw the 3D image, *IMO* provides two hardware renderers: OpenGL and DirectX. If your system has hardware acceleration for either OpenGL or Direct3D (note: you must have DirectX 5 or a later version installed), choose the appropriate renderer. Using hardware renderers can introduce limitations. Select a renderer to compare the performance and visual quality of hardware versus software rendering and set your preferences accordingly.

  **Renderer options**
  - **Wireframe rendering mode.** The object appears to be outlined with wires rather than solid.
  - **Dither colors if needed.** Controls whether Cortona dithers while rendering. Dithering improves the quality of rendering, but may lower performance.
  - **Motion blur effect.** Apply a motion blur effect. This actually makes an image seem a little blurred in motion.
  - **Anti-aliasing.** The technique for smoothing out jaggies in showing curves on computer monitor. There are two different modes: Idle-time and Real-time. If the Idle-time option is on, it is applied only for static scene. Whereas selecting Real-time initiates smoothing even in the viewer movement but results in decreasing frame rate.
  - **Limit textures size.** All textures are optimized for speed.
  - **Optimize texture for quality.** All textures are optimized for quality. Note that if you select both Limit textures size and Optimize texture for quality, the renderer uses the available resources to optimize speed and quality simultaneously.
  - **Do not render textures.** To turn the textures on or off.
  - **Use textures mip-mapping.** When the scene contains acutely angled polygons that disappear into the distance, mixes low- and high-resolution versions of the same texture to reduce the jagged effect.
  - **Automatic level of detail.** Automatically reduces the number of polygons which are displayed for any object at large distances (tiny objects on computer screen) from the viewer.
  - **Phong lighting model.** A particular method for computing the apparent color of a face at a particular point. It improves the quality of lighting, but lower performance. Note that this option is available only for R98 Renderer in the Intel Pentium III optimization mode.

  **Optimization mode**
  Turns the optimization rendering mode on or off, if available.

  **Colors**
  The Properties box lists the screen elements for which you can change the color settings:
  - **BackColor.** A background color of the 3D View window
  - **RibHighlightColor.** Defines color for the acute edges (the Detect Ribs command on the Action menu).
  - **ShapeHighlightColor.** Defines color for the selected shapes. Note that the shape will be lit only if the Highlight Selection option is turned on.

  The Color Set box lists the colors you can use for the selected item in the Properties box. The Edit Custom Color button allows you to set a custom color instead of the standard choice.
Optimization and Conversion

Preprocessing

Before starting to simplify a model, you should perform preprocessing. This technique prepares the model for further optimization. During preprocessing, the following procedures are performed:

- The duplicated vertices are removed.
- The closely spaced vertices with a distance between them less than the value specified by the Vertex concatenation radius are combined.
- Several abutted shapes with the same material and texture can be joined together, if possible, to the single shape.
- Optionally, primitives are converted to IndexedFaceSet VRML nodes.

**Note:** It is strongly recommended that you preprocess first. The preprocessing procedure is impossible if you have made some modification in the model. Skipping this step can result in less optimization. For example, when importing CAD models in VRML 1.0 or DXF file format, each CAD part is represented by a number of small indexed face sets that use a common (the same) set of vertices. To simplify these parts, their component face sets should be merged into one shape.

To perform preprocessing:

1. Choose **Preprocess Model** from the **Action** menu, or click **Preprocess Model** on the Action toolbar.
2. Click OK when preprocessing is completed.
3. If you have unsatisfactory results, for example, some parts of a model are combined, you can undo the last action, and repeat the preprocessing with new preprocessor options.

Preprocessor Options

Preprocessor Options allow you to set properties for the preprocessing procedure.

**To open the Preprocessor Options dialog box:**

- On the **Option** menu, click the **Preprocessor** item.

**Vertex concatenation radius**

While preprocessing, **IMO** automatically determines the vertex concatenation radius that indicates the minimum distance between the closely spaced vertices; all vertices inside that radius will be replaced with the single vertex.

1. Select the **Set radius to** option in the Preprocessor Options dialog box
2. In the Vertex concatenation radius box, enter a number to change the radius in the range from 1.e-10 to 0.001, in metres.
3. Click OK.

**Convert primitives to indexed face set**

Converts primitives to the IndexedFaceSet VRML nodes during the preprocessing procedure. By default, it is inactive.
Optimizing polygonal mesh of objects

Using a polygon reduction technique, you can generate the simplified surface for IndexedFaceSet and SplineFaceSet. In the case of SplineFaceSet, in Cortona this technique does not change the real or visible number of polygons, but allows you to modify a mesh formed by polygons which is used as the initial approximation for spline shapes. It allows you to reduce the data needed for surface calculation and consequently to reduce a VRML file.

To modify polygonal mesh:

1. Select the shapes to be optimized (see Selecting Shapes from Basic Operations).
2. Click **Optimize** on the Action toolbar, or choose **Optimize** from the Action menu. The Optimizer Options dialog box appears.
3. Set the optimization ratio by dragging the Optimization ratio slider in the Optimizer Options dialog or enter the desired values to the Ratio field.

   **Ratio.** The optimization ratio parameter shows the difference between the sources polygon count and destination polygon count divided by the source polygon count. The closer this parameter is to 1, the simpler the possible polygonal mesh of a model.

   **Optimization sharpness.** This allows you to give a hint to the /MO program for smoothing out tiny details of a shape that have a thin edge or a fine point. To specify the optimization sharpness parameter, drag the slider or enter the desired value in the Sharpness field. This defines the degree of smoothing in the range from 0 (a quick smoothing of sharp details in optimizing) to 1 (slow smoothing).

4. Click OK. This starts the process of optimizing. The optimization time required will vary with the complexity of model and reaches tens of minutes for models composed of hundreds of thousands of polygons. You can cancel this process by pressing ESC.
5. The Choose Optimization Ratio dialog then appears. At this stage you can choose the desired polygon count of the previously selected shapes by dragging the slider. The modifications can also be made separately for every one of the selected shapes. Just select the shape in the Scene Tree or 3D View window, set up the polygon count you want, and then deselect this shape to prevent further modification.

   All changes will be immediately shown in the 3D View, and you can test the simplified shapes using the common navigation's commands and changing the model view (on the View toolbar). You can also tune the crease angle for the selected shapes.

   An efficient way to complete this step for the group of selected shapes is to do the following: drag the slider to the right until all of the shapes look correct; in the 3D View window, CTRL-click the shapes you do not want for further optimization in order to deselect them, and so on.

6. When you finish, click Close.

   **Note:** Both the optimization and editing process in /MO are performed only with the unique geometry. Because of this fact, the Choose Optimization Ratio dialog shows information about the unique polygon count.

   **See Also**
   Crease Angle Tuner

**Step-by-step optimization**

Using this option allows the user to go through the optimization process automatically.

- Open a model and choose **AUTO** from the Action menu. Preprocessing and optimization with predefined options will be performed for all shapes.
Spline Surface

ParallelGraphics' Cortona VRML client supports spline representation of geometrical objects. Typically, by using the VRML97 file format, the faces are used to build curvy shapes. There are two choices to avoid faceted shading: use many more faces to approximate the smooth shape, or shade the faces differently so it looks like you've used a lot of faces (Gouraud method). However, the spline objects are geometrically smooth and allow for any quantity of faces to be displayed:

Faceted shape (crease angle = 0)

Smoothly shaded (crease angle = 45, in degrees)

Spline surface

From a mathematical point of view, the surface of SplineFaceSet in Cortona VRML client is produced using a mesh formed by constructing faces (polygons) and the value of the Crease Angle factor. The vertices for a base mesh are used directly from the coord field of VRML node. When rendering, this mesh is used for building a spline surface as its initial approximation. To achieve the high quality, this spline surface should be represented (tessellated) with a triangular mesh approximating the spline surface. The quality of such approximation is controllable as a function of the distance between the spline shape (its surface) and the viewer and the value of the quality parameter. You can give hints to the surface tessellator (not available in this version) about the quality of the spline surface defining the distance and quality fields (called the quality function) in VRML file. The quality function is defined on the interval of distances in the range from 0 to infinity, and its value is defined from 0 to 1 with 0 for the worst quality and 1 for the best surface.

How to convert VRML nodes

To convert to a spline shape:

1. Select the shapes you want to convert (see Selecting Shapes from Basic Operations).
2. Click Convert To Splines on the Action menu to convert IndexedFaceSet into SplineFaceSet.
3. On the Action menu, choose Crease Angle Tuner. The Crease Angle Tuner dialog box appears. Drag its slider or enter the crease angle value in degrees, then click Apply to see whether a smooth look has been achieved. Click OK.

To convert to IndexedFaceSet:

- Click Convert To Facesets to convert SplineFaceSet into IndexedFaceSet.
Optimization and Conversion

Note:
- The icon represents a polygonal shape, while the icon is used for a spline shape.
- To undo your last conversion, click Undo on the Edit menu.

Crease Angle Tuner

To achieve a smooth look to your model, you can tune the crease angle of the selected shapes. If the angle between the geometric normals of two adjacent faces is less than, or equal to, the specified value for the crease angle parameter, the edge between the two adjacent faces is smooth-shaded. Otherwise, the appearance of rendered surface is calculated so that a lighting discontinuity across the edge is produced.

A high crease angle parameter can reduce the number of polygons necessary to create a smooth look, but note that if you look at an angle edge-on, you can often see it clearly even if it is smooth-shaded from the front.

To tune the crease angle:

1. Select the shapes which you want to modify (see Selecting Shapes from Basic Operations).
2. On the Action menu, choose Crease Angle Tuner. The Crease Angle Tuner dialog box appears. Drag its slider or enter crease angle value in degrees, then click Apply to gauge whether a smooth look has been achieved.

Batch optimization

This option helps you to create multiple object optimization. It is useful for the automatic optimization of models with equally specified preprocessor and optimizer settings.

1. Specify properties for preprocessing and the optimization ratio parameter in the Optimizer Properties dialog box (click Optimizer from the Option menu to display it).
2. On the File menu, click Batch optimization, the Batch optimization dialog box appears.
3. Select the file to be optimized by clicking it. To select more than one file, hold down the CTRL key, and then click the items you want.
4. Select the folder where you want to put the copy.
5. Click Start.
Edit Edges

In the Edit Edges mode you can use the following functions:

- Rotate the edge within its bounding. This sometimes gets better results in simplifying the mesh of a shape.
- Show ribs that are formed by two adjacent faces with the angle between their normals greater than the specified value for the crease angle parameter. These ribs will be saved during the optimization process.

**Note:** When you edit a shape, all instances of the shape are also modified.

**To enter the Edit Edges mode:**
- Click Edit Edges on the Edit toolbar, or on the Edit menu point to Edit Mode and choose Edges.

**To rotate the edge:**
1. Select the shape you want to edit in the Scene Tree window by clicking it.
2. Enter the Edit edges mode, the model appears in the wireframe view.
3. Double-click the edge to flip it. The edge will be rotated as shown in the following figure:

![Rotation Example]

**To show acute edges:**
1. Select the shape for which you want to show acute edges.
2. Set-up the crease angle parameter, by clicking the Crease Angle Tuner on the Action toolbar. If the incoming VRML file contains the creaseAngle field, the value of this field will be used for finding acute edges, but you can also change it by using Crease Angle Tuner.
3. Choose Detect Ribs from the Action menu. The acute edges will be shown in red. Please note that you can change the default color for the acute edges: right-click somewhere in 3D View, choose Properties, click the Colors tab, in the Property Name list select RibHighlightColor, and choose the desired color from the palette.

**To mark the edge as acute edge:**
- Click the edge on the 3D View window while holding down the CTRL key. To disable the selection, control-click it again.

Edit Vertices

Provides commands to edit vertices of the polygonal mesh of selected shape. This allows you to select the vertex or a group of vertices in the 3D View and move them around by using the Vertex manipulator controls.

**To enter the Edit Vertices mode:**
- Click Edit Vertices on the Edit toolbar, or on the Edit menu point to Edit Mode and choose Vertices.
To show the Vertex manipulator controls and move vertex:
- Click the vertex in the 3D View. This shows the vertex controls: yellow boxes in each direction. When you position the mouse pointer over the control, the box is colored in red:

![Vertex manipulator controls](image)

When you drag the center of the manipulator, the vertex is moved in the plane of your screen. When you drag the Vertex manipulator control, the vertex is moved in the corresponding direction.

**Note:** If multiple references to the shape are used in the model, you can select the vertex for any shape, but the vertex controls appear only for the definition. When you edit the vertex, the references always reflect the changes of its definition.

To select a group of vertices:
- Click vertices in 3D View one by one. The vertex controls appear in the center of this group:

![Group of vertices](image)

To cancel the selection:
- Click anywhere on an empty part of the 3D View.

To delete the vertex:
- Select it in 3D View and choose **Delete Selection** from the **Edit** menu or click on the **Standard** toolbar or press the Delete key.

To add the vertex to edge or face:
- Click where you want to add the vertex while holding down SHIFT (add to edge) or CTRL (add to face).
Material Editor

The Material Editor provides functions to assign material to individual shapes and to create and edit surface materials. Specifying a color and material properties allows you to add greater realism to a VRML scene. A material describes how an object reflects or transmits light.

To view the Material Editor, click the Edit Material button on the Action toolbar, or choose Edit Material from the Action menu.

When you start the Material Editor you see an arrangement of screen elements, which is described below.

**Material Preview**. This displays the current material on a sample sphere. You can change the material by using the

**Material Editor controls**. To assign the material to the currently selected shapes, click Apply. To save the edited material to the User Defined Colors category, click Save.

**Category list**. The Category box lists the contents of a material library that you can use for selected shapes.

**Sample Collection**. Displays the collection of currently active material samples. You can select and preview the material on a sample sphere by clicking the material icon.

**Color controls**. These controls allow you to change a color component in the material.

- **Diffuse color** describes the color of light that an object reflects when illuminated by white light.
- **Specular color** determines the color of the specular area of a highly reflective object.
- **Emissive color** indicates that the object glows on its own.
**Material Editor**

**Material Properties controls**
These allow you to specify ambient, shininess, and transparency material components.

- **Shininess** determines the size of the specular area of a highly reflective object. Lower shininess values produce soft glows, while higher values result in sharper, smaller highlights.
- **Ambient intensity** specifies how much ambient light from light sources the surface will reflect. Ambient light in VRML simulates light that does not come directly from a light source. It is the general light that illuminates the entire scene. Ambient light is omni-directional and depends only on the number of light sources, not their positions with respect to the surface.
- **Transparency** specifies the degree of transparency of an object, ranging from 0.0 for completely opaque surface to 1.1 for completely “clear” surface.

**Procedures**

**To apply a material to a shape in a scene:**

1. Select the shapes you want to assign the material to.
2. Start Material Editor by clicking **Material Editor** from the Action menu.
3. You can modify a current material or specify a new one by using the Material Editor controls’ or by selecting a material from the material library. To select a readymade material, select the category of the material library that contains the material you want to assign, click the material icon in the Sample Collection window. The selected material appears in the Material Preview.
4. Click Apply to display changes in the 3D View window. Click OK.

**Notes:**
- When you change the material's properties, **IMO** updates the scene in the 3D View only when you click the OK button.
- To display changes in the scene immediately, select the Auto Apply check box.

**To save the current material:**
- Click the Save button. This saves the material into the User Defined Colors category library.

**To delete the material from the User Defined Colors category:**
- Select the material you want to delete by clicking its icon in the Sample Collection window, press Delete. There is no way to delete materials from other categories.

**Note:** When specifying a new material by using Material Editor controls, you can press **<Page Up>**, **<Page Down>**, **<Home>**, **<End>**, and arrow keys to move the slider.

**Designing Materials**

This topic provides suggestions for ways you can use **IMO** to design materials. The Material Editor gives you a number of controls in material design. In general, when you create a new material and apply it to a shape, you follow these steps:

1. Select the shapes and start the Material Editor.
2. Enter settings for the various material components: diffuse color, shininess, transparency, and so on by dragging the slider on the tab you need or by typing values in the corresponding boxes. The current face material appears in the Material Preview on a sample sphere.
3. Save the material and apply it to the shape.

A material’s attributes describe the visual and optical properties of a material – its color, how it reflects light, and how transparent it is. These are used by the VRML lighting equations during rendering. You can give an object (a shape in **IMO**) the following appearance to determine how light reflects off an object to create color:

- **Diffuse color** describes the color of light that reflects most from the object. The surface with the diffuse component reflects all VRML light sources depending on the angle of the surface with
respect to the light source. The more directly the surface faces the light, the more diffuse light is reflected.

- **Specular color** and **Shininess** determine the color and the size of the specular area on the highly reflective object, the color of the light that reflects directly back to the viewer. When the angle from the light to the surface is close to the angle from the surface to the viewer, the specular component is added to the diffuse and ambient color calculations. Lower shininess values produce soft glows, while higher values result in sharper, smaller highlights.

- **Emissive color** indicates that the object glows on its own. This can be useful, for instance, for displaying pre-lit models.

- **Ambient intensity** specifies how much ambient light from light sources the surface will reflect. Ambient light in VRML simulates light that does not come directly from a light source. It is the general light that illuminates the entire scene. Ambient light is omni-directional and depends only on the number of light sources, not their positions with respect to the surface.

- **Transparency** specifies the degree of transparency of an object, ranging from 0.0 for completely opaque surface to 1.1 for completely "clear" surface.

**Note:** The **IMO** program gives you the only light source for the illumination of a scene – the headlight. The headlight always shines directly in front of the camera and does not have an ambient lighting component. You can switch the headlight on and off.
This section contains explanations of various concepts and terms used in IMO, arranged alphabetically.

**ancestor nodes**
The ancestors of a node are all of the nodes that have the node as a descendant.

**Children node**
This is a node that descends from another node in the transformation hierarchy.

**crease angle**
In VRML, the creaseAngle field, used by the IndexedFaceSet node, specifies a shading type in rendering. In the IMO, to achieve a smooth look to your model, you can tune the crease angle of the selected shapes. If the angle between the geometric normals of two adjacent faces is less than or equal to the specified value for the crease angle parameter, the edge between the two adjacent faces is smooth-shaded. Otherwise, the appearance of rendered surface is calculated so that a lighting discontinuity across the edge is produced. The figure shows an edge-on view of two faces and the angle between their normals:

![crease angle diagram](image)

A high crease angle parameter can reduce the number of polygons necessary to create a smooth look, but note that if you look at an angle edge-on, you can often see it clearly even if it is smooth-shaded from the front.

In the case of SplineFaceSet, the crease angle determines how close the newly formed spline surface follows the vertices of a base mesh.

**definition**
A named node that can be referenced by the name later in the same file. In VRML, it is a DEF statement. See Instance.

**descendant nodes**
The descendants of a node are all of its children nodes.

**DXF**
DXF is an acronym for the Drawing Interchange Format. DXF files are used to import and export objects to and from AutoCAD (and other programs that support this file format). IMO supports DXF compatible with AutoCAD v.12.

When importing a model in DXF file format, the following types of entities are converted to IndexedFaceSet nodes of VRML:

- 3DFACE
- 3D POLYLINE (polygon mesh, polyface mesh)
- 2D-primitives are supported if a thickness parameter is specified: TRACE, SOLID, LINE, ARC, CIRCLE, ELLIPSE, 2D POLYLINE

IMO imports the first INSERT entity of every BLOCK as a Group node and gives it DEF name. All subsequent INSERT entities of the same block are converted to references of the named node. All other types of entities are ignored.
face
A VRML face is a flat shape, like a triangle, square, or octagon. The interior of the face is filled in by
the VRML browser and shaded. A face is also known as polygon. By arranging many adjacent sets of
faces it is possible to construct complex faceted shapes that provide the renderable surface of an
object. This polygonal surface is often represented with a triangular mesh, composed of a set of
vertices and a set of triangles. Please note that IMO treats all shapes as a set of triangular faces
performing the tessellation on the polygonal facets. IMO uses a successive vertex removal technique
to simplify a triangular mesh of a shape.

field
A property or attribute of a node. Each node type has a fixed set of fields. Fields may contain various
types of data and one or many values.

gamelet node
See shape.

Group node
A Group node contains children nodes without introducing a new transformation. It is equivalent to a
Transform node containing an identity transform.

IndexedFaceSet
The IndexedFaceSet node in VRML represents a 3D shape formed by constructing faces (polygons)
from the list of vertices. In IMO, the IndexedFaceSet nodes can be converted to SplineFaceSet. For
details about conversion, see How to convert nodes.

inlining
The mechanism by which one VRML file is hierarchically included in another. This enables you to
build each of the parts for the model in a separate VRML file. Inlining is similar to typical CAD
assembly file structure in that there is a VRML file that references other VRML files which contain
information about model parts.

instance
Any occurrence of the node in the scene graph. A node given a name using the DEF keyword
(definition) may be referenced by a name later in the same file with USE statements (reference). The
node definition and all its references are called instances.

The reference does not create a copy of the node. Instead, the same node is inserted into the scene
graph a second time, resulting in the node having multiple parents. Because of this, if a user selects
one of the node instances, all the node instances will be selected. Both optimization and editing in
IMO affect all node and their instances simultaneously.

instantiation
Using an instance of a node multiple times is called instantiation.

material
Material specifies surface material properties for associated geometry nodes and is used by the
VRML lighting equations during rendering. Materials affect the color of 3D objects, their shininess,
transparency and so on. For more details, see Designing Materials.

negative transformation
This is a Transform node with the negative values in the scale field. It is used to produce a mirror
image of the original surface.

The Shape nodes, which are children of such a transformation node are called the flipped shapes.
Please note that some CAD programs produce the negative values in the scale field of the Transform
node when exporting flipped shapes to VRML 1.0 file format. Because of this fact, IMO allows the
transformation of a coordinate system with a negative scale factor, though VRML97 specifies that the
scale field value must be greater than zero.

In certain cases, some of these flipped shapes may have all of their face normals flipped the wrong
way. The flipped shapes with the solid field equal to FALSE appear to be turned inside out. IMO
automatically finds flipped shapes when loading the VRML file and set up a solid field to TRUE.
A red icon for the transformation represents a negative transform in the Scene Tree window.

**node**
Nodes are the building blocks of VRML. Nodes describe shapes, colors, lights, placement of shapes built in a virtual world and so on. Nodes can be grouped together and a group can have any number of members, or children, which can be either nodes or other groups.

**IMO** operates with the following types of nodes:

- Geometry node (Shape)
- Transformation node

**optimization**
The optimization procedure lets you reduce the number of faces (triangles) and vertices in an ordinary polygonal shape and simplify a mesh which is used as the initial approximation for a spline shape. This simplifies the geometry and speeds up rendering while maintaining an acceptable image. The file size of a model is also reduced.

**parent node**
A node which is an ancestor of another node in the transformation hierarchy. See Transformation node.

**polygon**
A closed plane figure having three or more angles and straight sides. See face.

**preprocessing**
This technique prepares the model for further optimization by performing preliminary procedures. For more details, see Optimization and Conversion, Preprocessing.

**primitives**
There are four simple, compact types of geometry nodes in VRML that all VRML browsers understand without having to be told in detail how to draw them: Box, Cylinder, Sphere and Cone. These geometry nodes are called VRML primitives. In addition, the following VRML geometry nodes are also considered as primitives in IMO: ElevationGrid, Extrusion, and Text. Primitives cannot be simplified in IMO.

Optionally, primitives can be converted to an IndexedFaceSet VRML node during the preprocessing procedure (click the Preprocessor command from the Options menu, select the "Convert primitives to indexed face set" check box).

**reference**
It is a reference to a previously defined and named node. In VRML, it is a USE statement, which enables using a defined node multiple times in the same file. Nodes are referenced by names, given using a DEF keyword (definition). In the Scene Tree window, references appear with the link mark above the node icon.

The USE statement does not create a copy of the node. Instead, the same node is inserted into the scene graph a second time, resulting in the node having multiple parents. See instance.

**rendering**
The rendering process shades the design's geometry using the lighting set up in the scene and the materials applied.

**saving and publishing**
The Save command saves the scene into the same file it was opened from. Care must be taken not to overwrite the original file if you want to keep it. Use the Save as command to prevent original file loss. During optimization, use Save to store your current changes. Finally, when you reach the desired level of simplification with acceptable quality, use the Publish command. The Publish command saves the scene into a new file with additional reduction of the file size and resources publication. The publishing procedure removes all of the extra formatting and reduces the file to its minimum size. In addition to this, compression can be applied at this stage.
Scene graph
In IMO, it is an ordered collection of transformation and shape nodes.

The Scene Tree window presents information about a model structure and shows the transformation hierarchy of its constituent shapes.

Shape
The Shape node in VRML associates a geometry node with nodes that define that geometry's appearance. The Shape node also contains information that specifies the visual attributes (e.g., material and texture) to be applied to the geometry.

IMO operates with the following geometry nodes called shapes: IndexedFaceSet, SplineFaceSet – the spline equivalent of the IndexedFaceSet (VRML extension in Cortona), and Primitives. Each node type has a particular icon that is associated with it in the Scene Tree.

The user can modify material of any shape node in IMO. Primitives cannot be simplified (optimized) and edited in IMO unless they are converted to IndexedFaceSet or SplineFaceSet. IndexedFaceSet and SplineFaceSet form a base mesh of an object that, in turn, can be processed in IMO.

Spline
A type of curve that is interpolated between two endpoints and two or more tangent vectors. The term dates from 1756, and derives from a thin wood or metal strip used for drafting curves in architecture and ship design.

Solid
The solid field, used by the IndexedFaceSet, determines whether one or both sides of each polygon shall be displayed. If solid is FALSE, each polygon shall be visible regardless of the viewing direction. In IMO, the user can change this parameter (see the Shape Details dialog box available from the right mouse menu in the Scene Tree, Details).

SplineFaceSet
The SplineFaceSet node is a spline equivalent of the IndexedFaceSet VRML node. This is a VRML extension in Cortona VRML client. The method of spline representation is based on three-cubic spline interpolation, which is performed with the Cortona VRML client automatically using a base mesh formed by constructing faces (polygons), the value of the Crease Angle factor, and the specified distance and quality fields. The vertices for a base mesh are used directly from the coord field of VRML node. When rendering, this mesh is used for building a spline surface as its initial approximation.

Spline surface
Spline surface is an alternative to polygonal representation of geometry objects. The method of spline representation is based on the spline interpolation, which is performed with Cortona VRML client automatically using a base mesh formed by constructing faces (polygons).

Texture
A 2D image that is applied to a surface to add visual detail. It can be in JPEG or PNG file format.

Transformation hierarchy
The transformation hierarchy includes all of the root nodes and root node descendants that are considered to have one or more particular locations in the virtual world. In VRML it is possible to create any number of coordinate systems for positioning shapes. Each descendant coordinate system is positioned, or translated, relative to the origin of the ancestor coordinate system.

Transform node
The Transform node is a grouping node that defines a coordinate system for its children that is relative to the coordinate systems of its ancestors.

Transformation nodes
The sub-collection of VRML grouping nodes. In VRML, grouping nodes have a list of children nodes. Each grouping node defines a coordinate system for its children. This coordinate system is relative to the coordinate system of the node of which the group node is a child. Such a node is called a parent.
node. This means that transformations accumulate down the scene graph hierarchy. The children may themselves be instances of grouping nodes, thus forming a transformation hierarchy.

**IMO** operates with the following transformation nodes: Transform node and Group node.

**triangle**

In the context of **IMO**, a triangle is the smallest possible element of a mesh object. The triangle is a face formed by three vertices.

**unique geometry**

The scene geometry nodes without references. Both the optimization and editing process in **IMO** are performed with the original shapes, but the references only reflect the changes of its definition.

Any modification made to the original geometry is passed on to its references and these changes are reflected in the 3D View window.

**viewer**

A location, direction and viewing angle in a virtual world that determine the portion of the virtual world represented in the 3D View window.

**VRML**

VRML is an acronym for the Virtual Reality Modeling Language. VRML97 is an ISO/IEC 14772:1977 standard specifying the text based file format for the description of 3D interactive worlds. VRML97 is the most recent revision of the VRML specification. Please note that when importing a file in VRML 1.0, **IMO** converts it to VRML97.

Most 3D CAD packages support this format and **IMO** can read all output from the major packages VRML is the ideal Web based language since it allows easy integration into HTML and scripting in various languages. It is also capable of animation and lends itself to product demonstrations and instruction manuals.

**IMO** supports only those VRML nodes that specify geometry and its appearance. The rest of the nodes, such as viewpoints, light sources, interpolators, scripts and others, are removed. The following lists all of the VRML nodes that **IMO** supports:

- Appearance
- Box
- Color
- Cone
- Coordinate
- Cylinder
- ElevationGrid
- Extrusion
- FontStyle
- Group
- ImageTexture
- IndexedFaceSet
- Inline
- Material
- PixelTexture
- Shape
- Sphere
- Text
- TextureCoordinate
- TextureTransform
- Transform

Cortona VRML extensions:
- SplineFaceSet
- SplineCone
- SplineCylinder
- SplineElevationGrid
- SplineExtrusion
- SplineSphere
**VRML file**
See VRML scene.

**VRML scene**
A set of VRML nodes and statements as defined in ISO/IEC 14772. This set of VRML nodes and statements may be in the form of a single file, or an in-line sequence of VRML information as defined by a particular VRML encoding.